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ABSTRACT 

The electrical system is an important component in modern infrastructure, because almost all devices used in 

human activities today use electricity as a resource. To maintain the continuity of these activities, a system is 

needed that can monitor electrical conditions in real time in order to prevent bigger problems from occurring 

in the electrical system. This monitoring system uses the PZEM-004T to measure voltage, current, and 

frequency. NodeMCU ESP8266 to help display data such as, Voltage, Current, and Frequency on I2C and 

Blynk LCDs. I2C LCD to display Voltage, Current and Frequency. And Blynk to display Voltage, Current and 

Frequency. The results of the tests that have been carried out have an average error value of 0.0012% for 

voltage and 0.28% for current. Where the average error value in each test is below the tolerance value stated 

in the PZEM-004T sensor specifications, which is 0.5%. 
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ABSTRAK 

Sistem kelistrikan merupakan salah satu komponen penting dalam infrastruktur modern, karena hampir seluruh 

perangkat yang digunakan dalam aktivitas manusia saat ini menggunakan listrik sebagai sumber daya. Untuk 

menjaga keberlangsungan aktivitas tersebut, dibutuhkan sistem yang dapat memantau kondisi kelistrikan 

secara realtime agar dapat mencegah terjadinya masalah yang lebih besar pada sistem kelistrikan. Sistem 

monitoring ini menggunakan PZEM-004T untuk mengukur tegangan, arus, dan frekuensi. 

NodeMCU ESP8266 untuk membantu menampilkan data seperti, Tegangan, Arus, dan Frekuensi 

pada LCD I2C dan Blynk. LCD I2C untuk menampilkan Tegangan, Arus, dan Frekuensi. Dan Blynk 

untuk menampilkan Tegangan, Arus, dan Frekuensi. Hasil pengujian yang sudah dilakukan terdapat nilai 

rata-rata error tegangan 0,0012% dan arus 0,28%. Dimana nilai rata-rata error dalam setiap pengujiannya 

berada dibawah nilai toleransi yang tertera pada spesifikasi sensor PZEM-004T yaitu 0,5%. 

 

Kata kunci: Monitoring, Tegangan, Arus, Frekuensi, Blynk 
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1. PENDAHULUAN 
Sistem kelistrikan merupakan salah satu komponen 

penting dalam infrastruktur modern, karena hampir 

seluruh perangkat yang digunakan dalam aktivitas 

manusia saat ini menggunakan listrik sebagai 

sumber daya. Untuk menjaga keberlangsungan 

aktivitas tersebut, dibutuhkan sistem yang dapat 

memantau kondisi kelistrikan secara realtime agar 

dapat mencegah terjadinya masalah yang lebih 

besar pada sistem kelistrikan. 

Dalam pengembangan teknologi Internet of Things 

(IoT), banyak perangkat yang dapat digunakan 

untuk memonitoring kelistrikan. Dengan 

memanfaatkan IoT, kita dapat memonitoring 

kelistrikan secara realtime tanpa harus secara fisik 

berada di lokasi pemantauan. Selain itu, dengan 

memanfaatkan IoT, data yang diperoleh dapat 

diolah dan dianalisis dengan lebih mudah sehingga 

dapat membantu dalam pengambilan keputusan. 

Namun, hingga saat ini belum banyak sistem 

monitoring kelistrikan yang memanfaatkan IoT di 

Indonesia, terutama untuk sistem monitoring listrik 

3 phasa. Oleh karena itu, proyek akhir ini bertujuan 

untuk merancang dan membangun sistem 

monitoring listrik 3 phasa berbasis IoT. 

 

2. METODE PENELITIAN 

 
Gambar 1. Diagram Alir Penellitian 

 
A. Identifikasi Masalah 

Identifikasi masalah merupakan langkah awal 

dalam melakukan suatu rancang bangun pada 

sistem monitoring listrik 3 phasa berbasis internet of 

things (iot). Proses ini berfungsi untuk mengetahui 

permasalahan yang terjadi sehingga dapat terjadinya 

proses pembuatan rancang bangun sistem 

monitoring listrik 3 phasa di gedung lab kuliah 

Politeknik Negeri Ketapang sehingga bisa 

diterapkan dalam Proyek Akhir ini. 

B. Pengumpulan Data 

Pengumpulan data adalah proses yang dilakukan 

untuk mengumpulkan bahan-bahan dan alat yang 

diperlukan untuk membuat rancang bangun sistem 

monitoring listrik 3 phasa. Maka metode yang 

diperlukan dalam pengumpulan data ini 

diantaranya: 

1. Observasi 

Observasi merupakan metode pengumpulan data 

yang dilakukan dengan cara melakukan pengamatan 

langsung di lapangan, mengenai permasalahan yang 

ditinjau. Pada proses ini biasanya data diperoleh 

dengan terjun langsung ke lokasi tempat 

dilakukannya, penelitian sebagai penerapan dari 

rancang bangun sistem monitoring. 

2. Studi Literatur 

Studi literatur merupakan metode pengumpulan 

data yang dilakukann dengan cara memperoleh dari 

buku-buku yang berkaitan rancang bangun sistem 

monitoring listrik 3 phasa, maupun dari jurnal-

jurnal dan sumber dari internet. 

C. Perancangan 

Perancangan adalah sebuah proses untuk 

mendefinisikan sesuatu yang akan dikerjakan 

dengan menggunakan teknik yang bervariasi serta 

didalamnya melibatkan deskripsi mengenai 

arsitektur serta detail komponen dan juga 

keterbatasan yang akan dialami dalam proses 

pengerjaannya. 

D. Hasil Perancangan 

Setelah melakukan perhitungan dari komponen-

komponen yang diperlukan, apabila hasil 

perancangan belum selesai atau tidak sesuai, maka 

perlu kembali lagi pada tahap studi literatur untuk 

melakukan pengumpulan data. Apabila hasil 

perancangan sudah sesuai dengan data beban maka 

berikutnya adalah lanjut pada kesimpulan dan 

selesai. 

E. Kesimpulan  

Pada proses ini merupakan hasil akhir dari Proyek 

Akhir, yaitu mengambil kesimpulan dari data 

rancang bangun yang telah dilakukan. Setelah 

semua tahapan dilakukan hingga proses pengujian 

selesai, jika semuanya berjalan dengan baik, maka 

rancang bangun alat ini akan dilakukan pengujian 

kembali untuk memastikan kondisi alat memamg 

sudah benar dan berjalan dengan baik. 

3. HASIL DAN PEMBAHASAN 

3.1. Lokasi Pelaksanaan Proyek Akhir 
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Lokasi yang akan digunakan untuk pengujian 

sistem monitoring listrik 3 phasa adalah di Gedung 

Lab Politeknik Negeri Ketapang pada lantai 2. 

Dipilihnya lokasi ini karena untuk mempermudah 

pemantauan pemakaian listrik 3 phasa di Gedung 

Lab Politeknik Negeri Ketapang pada lantai 2. 

3.2. Wiring Diagram 

Hasil rangkaian wiring diagram dapat dilihat pada 

gambar dibawah ini. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 2. Wiring Diagram 

3.3. Perancangan Software 

Pengerjaan tugas akhir ini diawali dengan 

penggunaan aplikasi Android yang akan 

digunakan Monitoring Automastic Tranfer 

Switch (ATS). Aplikasi Blynk dapat diunduh 

di Play Store. Blynk memungkinkan untuk 

membuat project interface dengan berbagai 

macam komponen input output yang 

mendukung untuk pengiriman maupun 

penerimaan data serta merepresentasikan 

data sesuai dengan komponen yang dipilih. 

Representasi data dapat berbentuk visual 

angka maupun grafik. Terdapat 3 jenis 

kategori komponen yang berdapat pada 

Aplikasi Blynk antara lain: 

1. Controller digunakan untuk mengirimkan data 

atau perintah ke Hardware. 

2. Display   digunakan    untuk   menampilkan    

data    yang   berasal    dari 

3. hardware ke smartphone. 

4. Interface pengaturan tampilan pada 

aplikasi Blynk dapat berupa menu 

ataupun tab. 

3.4. Tampilan Menu Aplikasi Blynk 

 

 

 

 

 

 

 

 

 

Gambar 3. Tampilan Menu Aplikasi Blynk 

 

 Pada gambar tersebut merupakan tampilan 

login pada aplikasi Blynk. Email yang 

digunakan merupakan akun yang sudah 

didaftarakan pada Blynk. Apabila user lupa 

dengan password, user dapat menggati 

password dengan cara memilih Forgot 

Password. 

3.5. Pembuatan Template baru 

 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 4. Pembuatan Template baru 

 

Pada gambar di atas yang pertama adalah 

membuat nama template yang akan di beri 

nama. Yang kedua Create default Template di 

gunakan untuk membuat template default yang 

baru. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 5. Notif  Email dan Blynk 

 

Pada gambar di atas periksa email, Blynk akan 

mengirimkan Auth Token kode ke Email yang sudah 

digunakanuntuk Log In yang berfungsi sebagai 

penghubung perangkat yang akan digunakan. 

 

3.6. Pemilihan Widget box 

Untuk menambah komponen interface pada project 

dapat meneggunakan menu plus yang ada di pojok 

kanan atas. Terdapat berbagi macam komponen 
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yang diperlukan untuk mendukung tampilan. 

Berbagai macam komponen yang tersedia 

disesuaikan. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 6. Tampilan Widget box 

 

Pada gambar  di atas merupakan gambar Blynk 

yang siap di gunakan dengan penambahan widget 

dan sudah diatur sebagaimana port yang akan 

digunakan. 

Untuk widget yang digunakan adalah sebagai 

berikut : 

1. LCD, digunakan untuk menampilkan 

pemberitahuan apakah sumber daya yang di 

gunakan itu dari PLN 

2. Gauge, digunakan untuk menampilkan nilai 

tegangan, arus, frekuensi dari sensor PZEM- 

004T. 

 

3.7. Pengaturan Data Stream 

Data stream pada Blynk memungkinkan Anda 

untuk membuat aplikasi IoT yang responsif dan 

interaktif. Anda dapat mengirim dan menerima 

data secara real-time antara perangkat IoT dan 

aplikasi Blynk, memberikan kontrol penuh atas 

perangkat yang terhubung dan menyajikan 

informasi yang relevan kepada pengguna Anda 

 

 

 

 

 

 

 

 

 

 

Gambar 7. Pengaturan Data Stream  

 

Data stream di buat akan di koneksikan dengan 

setiap witget yang telah dibuat pada tampilan 

Blynk data stream yang di buat adalah sebagai 

berikut : 

a. Voltage (Tegangan) virtual pin yang 

digunakan V0, tipe datanya Double satuannya 

( V ), akan dikoneksikan pada witget Gauge 

tegangan. 

b. Arus, virtual pin yang di gunakan adalah 

V1, tipe datanya Double satuannya ( A ), 

akan dikoneksikan pada witget Gauge 

arus. 

c. Frekuensi, virtual pin yang di gunakan adalah 

V2, tipe datanya Double satuannya ( HZ ), akan 

dikoneksikan pada witget Gauge frekuensi. 

 

3.8. Konfigurasi Arduino IDE 

Adapun Langkah-Langkah Konfigurasi arduino 

IDE adalah sebagai berikut: 

a. Instalasi addnon ESP8266 dengan Arduino 

Board Manager. 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 8. Konfigurasi Arduino IDE 

 

Pada Gambar diatas untuk Install library ESP8266 

buka arduino IDE kemudian masuk ke menu 

preferences (File > Preferences ). Kemudian 

dibagian bawah jendela masukkan url library ke 

addition Boards Manager URL. Setelah 

menambahkan URL pada additional Board 

Manager kemudian masuk ke menu Board 

Manager (Tools > Boards > Boards Manager). 

Kemudian cari ESP8266 pada filter untuk 

memudahkan pencarian. Setelah itu klik Install. 

 

b. Instal Library Blynk 

Pada gambar dibawah ini saat memprogram 

NodeMCU ESP8266 yang mampu berkomunikasi 

dengan Blynk digunakan library Blynk. Library 

Blynk untuk arduino dapat diunduh melalui menu 

(Sketch > Include Library > Manage Libraries). 

Dilanjutkan dengan pencarian keyword Blynk pada 

isian pencarian 
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Gambar 9. Tampilan Instal Library Blynk 

 

c. Instal Library sensor PZEM-004T 

 

Gambar 10. Instal Library sensor PZEM-

004T 

 

Pada gambar dibawah ini saat memprogram 

NodeMCU ESP8266 yang mampu berkomunikasi 

dengan sensor PZEM-004T digunakan library 

PZEM- 004T. Library PZEM-004T pada sofware 

Arduino IDE dapat diunduh melalui menu 

(Sketch > Include Library > Manage Libraries). 

Dilanjutkan dengan pencarian keyword PZEM-

004T pada isian pencarian.  

 

3.9. Spesifikasi Komponen 

 

Pembuatan sistem monitoring listrik 3 phasa 

harus menggunakan spesifikasi untuk memilih 

komponen yang cocok. Adapun spesifikasi 

komponen yang dipakai adalah sebagai berikut. 

 

 

 

  
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3. KESIMPULAN 

Berdasarkan hasil yang diperoleh pada perancangan 

monitoring listrik 3 phasa berbasis Internet Of 

Things (IoT) dapat di simpulkan sebagai berikut. 

1. Alat ini di rancang dengan menggunakan 

program yang inisialisasi menggunakan software 

Arduino IDE. NodeMCU ESP8266 sebagai 

perangkat kendali yang menghubungkan PZEM-

004T dan Blynk berfungsi sebagai pendeteksi untuk 

mengetahui nilai Tegangan, Arus, Frekuensi pada 

beban yang digunakan pada pemakaian sumber 

listrik dari PLN di tampilkan monitoring di aplikasi 

Blynk pada Smartphone 

2. Menggunakan LCD 12C sebagai media 

yang akan menampilkan Tegangan, Arus, 

Frekuensi. 
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